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e Your computer is a invaluable part of your
Job search.

* Are you protecting your computer from

disaster?
— Virus, Spam, ID Theft, Spyware,

— Disaster (hard drive crash, loss of power,
power spikes and sags, fire, etc.)
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 There are many simple, inexpensive

approaches and some great FREE
software tools to help avoid disaster.
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e Always:

— uUse a surge protector or better yet an UPS
(uninterruptable power supply)

— use at least a software firewall and a
hardware firewall if available

— run anti-virus software and SPAM filters
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e Periodically:

— Run a complete anti-virus and anti-spyware
check of your System (more later about this)

— Run a defragmentation of your hard drive (more

later about this)
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e Periodically:

— Run a program to clean up orphan files,
duplicate files and trash on your hard drive

e Easy Duplicate File Finder - Looking to clean all

sorts of duplicate files? This tool does the job for
you. It scans your system, gives you a full report,
and lets you clean either in bulk or just selected
files. It also allows you to protect system files so
that you don't accidentally delete any important
ones that your PC needs to run.
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e Periodically:

— Run a check on the performance of your

computer to see if it is slowing down
» Glary Utilities - This excellent no-cost tool promises one-click

cleanup and optimization, and it delivers. It scans your system
for problems with the Registry, shortcuts, startup programs,
and spyware, and then gives you the option of which to clean
up. It also deletes traces of your Internet surfing and erases
temporary files. Optimization doesn't get simpler than this.

* Windows Memory Diagnostic
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e Periodically:

— Run a check on your Internet connection
to see if it has slowed down

« SG Speed Test - To test your current line speed,

simply choose a server based on your location,
and click its link below. The test may take up to
two minutes to complete. For more accurate
results, you should turn off any applications that
are currently using part of your bandwidth, such as
Internet audio/video streaming, VolP, P2P, etc.
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— Clean out unused and out of date files and
applications

— Do not download every “FREE” tool bar or
gimmick that is offered; most contain malware

— Organize your files and keep them organized
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— Clean your keyboard and if your computer is
on the floor, be sure to vacuum (not blow) the
dust out. Be sure your computer is turned off.

— Do you turn your computer off each night
or leave it on?

e You should turn your computer OFF at night.

 Just like you, your computer needs to shut down
and clean out its mind and start new and refreshed
the next morning.

e You also save power.
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e Virus Protection

— AVG FREE
e Use 8.5 (not v9.0)

— Microsoft Window Defender replaced by

Microsoft Security Essentials in 2009

— Avast
— Spybot Search and Destroy
— Kaspersky 2010 — If you want to purchase
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e Virus Protection
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e Virus Protection

— In addition to free software, several of these virus
protection software applications are available for
FREE or close to free using mail-in rebates. We

purchase the software from Fry's during the rebate
season. It is a small pain to fill out the rebates and
follow up, but worth it if to receive multi-user licenses
for just a small investment of your time.

— TIP: Carefully read the fine print on the forms and
MAKE COPIES OF EVERYTHING YOU SEND.
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e Email

— Web based
e Yahoo Mall
e Gmall (free POP)

e Hotmall
e AOL

— If you have a tx.rr.com or sbcglobal.net
account, what happens when you change
services...you lose you email address.
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e Email

— Web based vs Local based

 Web based...you can check mail on any computer
In the world.

e Local based (Window Mail, Outlook, Thunderbird)

— You must check ONLY on your local computer. You may
be able to check a web based version, but you will not
have your details.
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e Storage Back up

What should you back up?

e Everything that you use regularly or will
need Iin the long term
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 \WWhat do you use for a backup?
— Thumb Drives
— Portable Hard Drive

— DVD'’s of applications
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e How to Back up

— Start > All Programs > Accessories > System
Tools > Backup

e Don’t forget the Installation Keys

— These are the numbers and letters you enter
to activate the program. Write them down and
put with your back up.
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e How to speed up your computer

— Add RAM

e |nstall the maximum amount

« How do you know how much you can add...go to
to run a system test

— Start > All Programs > Accessories > System
Tools

* Run Disk Cleanup
 Run Defragmenter
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 Clean the Registry? (WITH CAUTION)

— There's a time and place for reqistry cleaners - If you
iInstall and uninstall a lot of software, there's the chance
that something can break, and registry cleaners can
help locate those issues. In most cases it's not going to

Improve performance... they will never make your
Celeron run like a quad core.

— Be sure to set a restore point and back up data before
doing this.

— - cleans both the registry and the
hard drives of stuff that is left over from browsing, log
files, program crashes, etc. Run it 1-2x per month
primarily for the HDD cleanup. The reqistry cleaner can
be run about every 1 to 3 months depending on their
preferences (if you install and uninstall lots of software.)
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e Microsoft Office 2007

— Can’t open .docx?

— If you are running Office 2003 and have not
up graded to 2007, there is a FREE

compatibility pack you can add on to your
2003 program that will allow you to open 2007
documents.

— MAKE SURE your updates are current.
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e Microsoft Office 2007

— One side note about Microsoft Office 2007. Office
2007 products are significant different in look and feel
than previous Office versions. Trying to create a very
simple spreadsheet took much, much longer than it

should have because | was unfamiliar with the new
ribbon tabs. If you use Excel or Word in your job, |
suggest people start to familiarize themselves with
the new look and feel.

— Also, you can purchase Classic Menu for Office 2007
for about $30. It gives you the classic menu feel of
Office 2003, but also includes the newer features of

Office 2007.
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 Open Office

— OpenOffice.org Is the leading open-source
office software suite for word processing,
spreadsheets, presentations, graphics,

databases and more. It works on all common
computers. It stores all your data in an
International open standard format and can
also read and write files from other common
office software packages. It can be
downloaded and used completely free of
charge for any purpose.
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 Open Office
— Writer (Word)
— Calc (Excel)

— Impress (Powerpoint)
— Draw
— Base (Access)

— Download from
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e To hold awebinar — up to 20 people

— DimDim.com - Free
e You can have up to 20 people on the webinar
e Three people can talk

e All can Chat

* You have a shared whiteboard

e You can load powerpoint presentations
e You can show your computer screen
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« To hold awebinar — up to 3 people

— Adobe ConnectNow — Free

* Meet live over the web and share computer
screens.

e Take control of another meeting participant's
desktop with permission.

* Video conferencing - With a webcam, use
multipoint video for a real in-person feel to your
online meeting
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e Other ways to connect : (two computers)

— Teamviewer - establishes connections to any
PC or server all around the world within just a
few seconds. You can remote control your

partner's PC as if you were sitting right in front
of It.

— LogMeln Free - Access and back up your
home or work computer from anywhere with
an Internet connection. It's fast, easy and
secure.
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e Need to find a good time to meet

— Doodle Easy Scheduler
« Schedule a poll or make a choice
e Send out the link to your group

e Individuals log in and enter their name and their
preferences

e You then know when you hold a meeting
e Sign up (FREE)
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 Need to find a good time to meet
— Doodle Easy Scheduler

November 2009

Mon Wed Thu
2 4 5

1:00 .00 11:00 12:00 10:00 11:00 12:00
PR Phd A Phd A A Phd

Jeff Morris Ok Ok Ok Ok Ok Ok Ok

Richard Solomon Ok Ok Ok Ok

Janet Freeman Ok

Clint Ford Ok

Lori Rains Ok

Ken Shine Ok

Marletta Holt

Rohert Kietzman

Your name
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e Need to convert a document to a .pdf

— doPDF6.3

o installs itself as a virtual PDF printer driver so after
a successful installation will appear in your
Printers and Faxes list. To convert to PDF, you
just have to print the document to doPDF, the free
pdf converter. Open a document (with Microsoft
Word, WordPad, NotePad or any other software),
choose Print and select doPDF. It will ask you
where to save the PDF file and when finished, the
PDF file will be automatically opened in your
default PDF viewer.
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 Need to convert from .pdf to Word

— PDF to Word

e you can quickly and easily create editable
DOC/RTF files, making it a cinch to re-use PDF

content in applications like Microsoft Word, Excel,
OpenOffice, and WordPerfect.
Best of all, it's entirely free!




CareerDFW

Giving you the tools you need to find your YO u r CO m p u ter

next great opportunity

« Need to convert from .pdf to Excel

— PDF to Excel

e quickly and easily create highly-editable XLS files,
making it a cinch to re-use tables and

spreadsheets from PDF files in Microsoft Excel,
OpenOffice, Google Docs, and WordPerfect Office.
Best of all, it's entirely free!
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 Need to edit a .pdf file

— PDFHammer

o edit your PDF files online without installing a thing!
Simply upload PDF files to PDF Hammer via your
web browser, perform your edits, and then save the
files back to your computer. The online editor allows
you to view the pages of your PDF files as you edit

them.

— Combine PDF.

— Edit PDF pages. Quickly rearrange, reorder, and delete the pages from
existing PDF files.

— Secure PDF. Protect the contents of PDF files with password-based
security.
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e Need to zip or unzip afile

— It may be built into your system
— 7 ZIp -

e Need aFTP

— CoreFTP Lite — This free, secure FTP client
gives you a fast, easy, reliable way to
update and maintain your website via
FTP. It also provides a secure method (via
SSL, TLS, or SFTP) to upload / download
files to and from FTP servers.
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e Mac

— You will find many free downloads at Open
Source Mac
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e Restore Points

— This Is a component of Microsoft's operating systems that
allows for the rolling back of system files, registry keys,
Installed programs, etc., to a previous state in the event of
malfunctioning or failure.

In System Restore, the user may create a new restore point
manually, roll back to an existing restore point, or change
the System Restore configuration. Moreover, the restore
itself can be undone. Old restore points are discarded Iin
order to keep the volume's usage within the specified
amount.

Start > All Programs > Accessories > System Tools >
Restore
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e Firewall

— This Is a part of a computer system or network
that is designed to block unauthorized access
while permitting authorized communications.

— It Is a device or set of devices configured to
permit, deny, encrypt, decrypt, or proxy all (in
and out) computer traffic between different
security domains based upon a set of rules
and other criteria.
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e Firewall

— Firewalls can be implemented in either
nardware or software, or a combination of
ooth. Firewalls are frequently used to prevent

unauthorized Internet users from accessing
private networks connected to the Internet,
especially intranets. All messages entering or
leaving the intranet pass through the firewall,
which examines each message and blocks
those that do not meet the specified security
criteria.
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e FREE Ouick Reference Cards

— Free two page reference guides for many
programs

— DO NOT reqister, just right click and save as a pdf file

any of the quick references.
Microsoft Access 2007, 2003,2002,2000..
* Microsoft Excel 2007,2003,2002,2000,97
« Microsoft FrontPage..
 Internet Explorer...
e Microsoft Office 2007
» Microsoft Outlook 2007, 2003,2002,..
» Microsoft Powerpoint..
» Microsoft Windows Vista, XP, 2000, 98
e Microsoft Word...
« Macintosh..
e Adobe...
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e Other FREE Programs

— Create, share and store your resume online
for free: (you can manage job

submissions and add notes — all one line. All
you need Is access to a PC — public
library/computer/friends computer)

— 10 best and free data recovery tools:
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e Other FREE Programs

— If you want to run applications from a USB
stick (you have what is called portable apps):

(these are FREE. Everything under the sun)

— Easy way to get FREE applications.:

— If you need OLD versions of applications:
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e To find this presentation on line...go to

— Click on the File tab, scroll down to section
15. Your Computer, click on that and open the
file called Your Computer




